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WORD INTERMEDIATE 
 

 File tab 

In the File tab, we find the classic options of the file menu of previous versions such as: open, close, 
save-as, and many more.  

 INFO

In INFO, we find two important options for our Intermediate Word course 

Here are some protection options 

 

 

Read only 

Making your document a read-only file means that the document can be copied and not modified. If 
someone tries to make changes to a read-only file, the changes can be saved only by giving a new name 
or saved to a new location. 
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Restrict Editing 

 Restrict for Review (Tracked changes – Comments) 

 Restrict to Filling in Forms 

 

Properties 

Do not forget Properties when you create a document 

1. Title will be important with your Header or Footer 

  

2. Related Dates 

 Last Modified 

 Created 

 Last Printed 

 

 

Check for issues 

Why use document inspection? 

 To remove all headers, footers, and watermarks 

 To eliminate all marks of revisions and the like... 
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IF YOU CLICK ON "INSPECT DOCUMENT", IT WILL ASK YOU TO SAVE TO PROTECT YOURSELF. 

Example: for revision marks, this one will assume that you accept all trademarks, so it is important to 
register under a different name. 

   

 RECOVER AN UNSAVED DOCUMENT

An unsaved document can be recovered, to perform this action, click "Open" 

  

   

This action will be available for as long as your computer remains 
open. 
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 NAVIGATION PANE

To make it easier to navigate through a long document, the document explorer becomes the navigation 

pane. 

 To open Navigation Pane, go to View Tab, Group Show, then Navigation Pane 

 Also, if you double click on Page x of xx located in the status bar 

   

   

If you look for the word Navigation:   

This section offers us 3 types of navigation:  

 Headings - Like a table of contents 

 Pages - Like a thumbnail image, per page 

 Results - Search for one or more words in the document 
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 Tabs 

You can use tab stops to create easy-to-format documents. The document layout options available in 
Word allow you to create, for example, a table of contents or an index without setting a tab stop. 

Word also provides preset options for table, header and footer, cover page, and others. These options 
make adding tab stops unnecessary. 

You can set tabs using the Tabs dialog box. The Tabs dialog box allows you to set more precise tab 
positions, as well as insert specific characters (dotted line) in front of the tabs.  

Tabs are used to align information in columns. By default, Word has tab stops at 1.25 cm (0.49 in.) 
intervals, visible by small marks at the bottom of the ruler. However, you are free to add or remove stops 
as you see fit. In addition, dots ranging from text to tab can be added. 

 

 TYPES OF TABS

Word offers several types of tabs. Each type is identified by a symbol visible on the ruler. 

Tab Symbol Function 

Left Tab  Aligns the text to the right of the tab. 

Centered Tab  Center the text on the tab. 

Right Tab  Aligns the text to the left of the tab. 

Decimal Tab  Aligns the decimal character to the tab. 

Bar Tab  Inserts a vertical line into a paragraph. 

1. On the Home tab, in the Paragraph group, click the Paragraph dialog box launcher, and then 
click Tabs at the bottom left of the Paragraph window  

   

2. In the Position box, enter the position (measure) on the ruler that 
you want to set for the tab stop. 

3. Under Alignment, choose Left, Center, Right, Decimal, or Bar.  

4. Under Leader, choose 1 None, 2 ........, 3 ------, or 4 __ to define 
(in the case of options 2, 3, and 4) a series of characters that link, 
for example, a section title to a page number. 

See EXERCISES: at the end of the document 
(p. 37-39) 
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 Mailings 

Word allows you to create a database, create letters, labels, directories, and send e-mail messages from 
the Mailings,  Start Mail Merge tab. 

Your database can come from Word or Excel or Access.  

 

When you are a not comfortable using Mailings, we 
suggest you use Step-by-Step Mail Merge Wizard… 

 

  

 LABELS OR ENVELOPES

 Open a new document 

 Mailings tab 

 Click on "Start Mail Merge" 

 When you first use Mail Merge, we suggest that you use Support, located in Start Mail 

Merge, and choose Step-by-step Mail Merge Wizard… 

   

Step 1 of 6 Choose Labels or Envelopes 
 Click Next 
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Step 2 of 6 Label or Envelope Options 
 Choose the necessary label template and click OK 
 Click Next 

Step 3 of 6 Click Browse 
 Choose File or Database 
 Insert Fields in the label 
 Click Next  

Step 4 of 6 Click on Update All Labels 

  
 Click Next 

Step 5 of 6 Edit List (If modification to be made) 
 Click Next and End of the Merge 

Step 6 of 6 Print or edit the document 

       



 

Page | 10  Word Intermediate  

 Click on Results Preview and Look for a recipient. 

 

  Click Edit Individual Labels 

 

 STEP 1: CHOOSE THE DOCUMENT TYPE

 The first step is to choose from the following options: 

 Letters 

 E-mail Messages 

 Envelopes…  

 Labels… 

 Directory 

 STEP 2: SELECT STARTING DOCUMENT 

Select the "Use Current Document" option to make the active Word file become the main merge 
document.  
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 STEP 3 TO 5: SELECT THE DATABASE AND APPLY A LAYOUT 

Select the "Use existing list" option and then click the Browse button.  

    

Remarks:  
 It is also possible to create a mail merge from the Outlook contact list.  

 The "Enter a new list" option allows you to create a new preformatted database (address 

book style). This database will be saved in mdb format after you have entered your data.  

 Locate and select the data source that contains the information you want to merge.  

 The list of tables is displayed in a new dialog box.  

 If the list is an Excel workbook, each sheet (or named range) is considered a table.  

 

 If the workbook contains more than one tab, select the tab in which you are interested.  

 Click OK to confirm.  

 If you later rename or move the database, you will need to recreate the link in the main 

document.  

 Use the following dialog box to sort and filter the recipients.  
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 Each column (field) contains an advanced filter that allows you to apply 5 AND/OR filter 

criteria, and 3 sorting criteria.  

 

 You can format your Word document.  

 Prepare the text you want to send. Next, you will add fields that will display the information 

in the database.  

 INSERT FIELD

 To insert a field into the Word document, click the "Insert Merge Field" button in the "Mail 

Merge" menu bar.  

 The window displays a list of fields in the database   

 Choose one of the Fields (e.g. "Name").  

 Then click on the "Insert" button.  

 Then click on the "Close" button  

 The field is inserted into the Word document at the cursor location.  

 Go to step 5 of the wizard to view the result.  

 The wizard provides a tool to scroll through the records and preview the inserted fields.  

Note 

 _________________________________________________________________________________  

 _________________________________________________________________________________  

 ___________________________________________________________________________ 

 ___________________________________________________________________________  
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 There is a second method to insert a field in the Word document:  

   

 The first 3 steps of the wizard must be completed beforehand  

   

 STEP 6: MERGE 

 The preparation is complete. You can start the merge.  

 Then, choose the Print or Edit Individual Letters option.  

 Print sends all the merge product to the printer. Use when you are sure of the result.  

 The Edit Individual Letters or Labels option allows you to review the entire merge 

product on the screen and make minor changes to certain records.  
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The following window will also be offered to select from everything.

 

 VIEW FILTERED OR SORTED RECORDS

The Word mail merge tool has a sorting option on each field in the database, allowing you to set the 
order of the letters.  

In step 3 of the wizard, click on the "Edit Recipient List" option.  

   

 For example, click on the "City" heading to have the Filter applied.  

 Click on Filter and choose Boucherville and Brossard 

    

 See how to Filter Records if we choose Boucherville and Brossard 
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 More options with the Filter Records 

 

 Then, we can Sort Records 

 

 Click the OK button to confirm.  

 The mailing preview now shows the letters or labels or directory with the city of 

Boucherville and Brossard.  

 CREATE A DIRECTORY

 

To create a  directory and to insert a table  to  obtain data wi th a cri terion  
(e.g.  Bouchervi l le or  Brossard)  

 Create a table: (one row and three columns) 

 Start Mailings 

 Database (Table Word) which is a Word document located in your Mailings folder. 

 Insert the fields: first name, last name, and city 

 Criteria: List of Boucherville and Brossard employees  

(Here is your criteria window below) 
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 Click on "Finish & Merge, then Edit Individual Documents..." 

Result of the “Directory"  

It is up to you to add a title line 

 

 RULES - IF... THEN... OTHERWISE...

This option allows us to insert conditional text based on the data contained in another field.  

   

For example, if you switch to field mode, you get:   

{IF Gender is equal to “W" "Mrs."}  

{Otherwise: is "Mr."} 

Please respect upper or lower case. 
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 MODIFICATION OF THE FIELD

 Right click in field, choose Edith Field… 

 This results in the following screen:  

 

Then use the text to be inserted afterwards and add the desired symbol "$", "%" or other.  

 

 "DATE" FIELD 

Often when mailing from an Access or Excel table, the date format is in International English. Mon, June 
3, 2024 will have the following format: 06/03/2024, although this date was entered in the format  
2024-06-03.  

The presentation of the dates can be changed by formatting the date field(s). To do this, after inserting 
all the merge fields,   

 Select each field with a date  

 Press Alt + F9 or SHIFT + F9, and you will see {MERGEFIELD}  

DATE_Inscription}   

 Position the cursor at the end of the field name, before the closing brace  

 Add the \@ switches (backslash and arrobas) followed by a space and then the desired 

format constructed according to the table below. This format should include quotation 

marks at the beginning and end. Example " d MMMM yyyy"   

Switch  Result  

d  Day with a number (this will avoid 01, 02, but will give 10, 15, 31)  

 Dd  Day with two digits dddd  Day in full M  Month with a number  
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 MM  Double-digit month MMMM  Month in full yy  Year in the double digits yyyy  the 

year in four digits hh  Time from 0 to 12 hours HH  Time from 0 to 24 hours  

 mm  Minutes  

 In bold, the most used formats.  

 If we want to get 2024-06-03, we will add \@  " yyyy –MM-dd"  

  
Pay attention to the mandatory space after the ":" in HH: mm  

 CURRENCY TYPE FIELD 

To get numbers with the currency symbol or to have decimals, you will also need to use a "\#" switch 
and the format   

So ####.00 will allow a number such as $222,240.50 to display correctly.  

By omitting the 00s, the number will have no decimals  

You can also use the "Edit Field" option obtained by the right clicking when positioned on the field to be 
modified.  

 Screenshot 

 

Even faster than screen printing and no need to 
trim 

Here is how to do it 

 Open a new document 

 Open a web page 

 Choose an image 

 Go back to your Word document and position yourself where you want the image 

 From the Insert tab, group 'Illustrations', select Screenshot, and choose Screen 

Clipping and take the latest one with the camera 

 This will go back to your last display, which is the web page, then with the mouse, frame 

only the part of the image you want to keep. 

 This image or text box can be saved as an "Image" 
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 Object 

There are times when you need to insert in a Word report for example, pdf documents, an Excel 

spreadsheet, a PowerPoint presentation, or another Word file and other instead of a copy and paste. 

You can even insert objects linked to the source files, in the case of external documents that are 

scheduled to be updated, so that they are automatically updated in the main document where they were 

inserted as soon as they are opened. This method simply uses insertion links to avoid storing all linked 

files.  

Your files can therefore be inserted as text, object, or simply as an icon.  

Process: 

From the Insert tab, go to the Text section and click the Object icon. 

   

What you can insert: 

 To create a document from a file, click the tab of the same name, click Browse, choose 

document from your browser. If necessary, click Link to File. The View as icon choice 

creates a hyperlink that will allow access to the linked document by a simple double click. 

 

Note 

 _________________________________________________________________________________  

 _________________________________________________________________________________  

 _________________________________________________________________________________  

 _________________________________________________________________________________  
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 LINK TO FILE

In case you have inserted objects with links, Microsoft Word will display a 
dialog box asking if you want to update these links each time you open 
them. 

You can always click No to update if you want to keep the old info for your document in question. 

 

 SHOW AS ICON

This option is very interesting, insert a file into a file, obviously, 
the file cannot insert with link if you send this document by email. 

 

 COPY & PASTE WITH LINK

See how you can proceed with copy & paste with link. 

 Open the document "Endangered Animals" and the Excel file "Chart_Data" 

 Copy the table from Excel  

 Go to the end of the Word document,  

and choose Paste Special 

 

 Make changes in Excel and see the result 
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 Repeat the copy and paste with link, but this time with the graph that you will drop after the 

table 

 This method is the same for paste with link in PowerPoint. 

  

 Convert a PDF document to Word format  

 WHY CONVERT A PDF TO WORD FORMAT?

Because we want to extract part of the document to avoid having to retype it all 

How to do it? 

 Open Word 

 From “Open “, go to a PDF document you have or Open "Bengal tiger.pdf" file  

 Observe the window below 

 

 Obviously, if the PDF document is in image format (scanned document), this option will not 

be available.  

Be careful, errors are possible, e.g. non-breaking space, displaced image 
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 Cover Page 

A cover page is the first page of a document. We 

will be able to insert this cover page, from the 

“Insert" tab, of the "Pages" group. 

We can easily add new Cover Page in our auto-

inserts that can be found in the Tab Insert 

Quick Parts  

Or by selecting your page and adding it to: "Save 
Selection to Cover Page Gallery..." 

 

 

 Quick Parts 

You can use the Quick Parts Component Gallery to create, store, and reuse content items, including 
auto-Insert, document properties (for example, title and author), and fields. These reusable content 
blocks are also referred to as building blocks. AutoText is a common type of building blocks that contain 
text and graphics. You can use the Building Block Organizer to search for or edit a building block. 

To open the Quick Parts Component Gallery, on the Insert tab, in the text group, click Quick Parts 
Components. 

  

 AUTOTEXT IN QUICK PARTS
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 INSERT YOUR SIGNATURE INTO AUTOTEXT

 Click where you want a field to be inserted 

 Type your full name, as well as 2 or 3 lines, you can also insert your company logo 

Type in your name 

Phone: 555-555-5555 

Email: prenom.nom@bell.net 

 Select All 

 Insert tab - Quick Parts - AutoText - Save Selection to Quick Part Gallery 

  

 Give your AutoText a name to be able to track it: Example: Registration 

 Closes without saving 

 Open a new document 

 Insert tab – Quick Parts – AutoText, you will find your text to insert 

 ANOTHER METHOD TO ACHIEVE THE SAME RESULT

 In Quick Parts, "click Building Block Organizer" 

   

 In the Gallery area, click an AutoText 

 Give it a name  
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 EXERCISE "HEADER" GALLERY

1. Type the text below 

2. Select and Save to the "Header" Gallery 

Formation CAD (CAD Academy) 
400 St-Martin Blvd. West 

Suite 200, Laval, Quebec H7V 3Y8 

 

 

We just add a Header  into the Header  Gallery .  

Now, you understand how to add a F ooter  in Footer Gallery  

 EXERCISE - QUICK PARTS – AUTO TEXT

1. Type the text below 

2. Insert a tab for the last 3 lines: 6.5cm, left stop 

3. Select All (CTRL+A) 

4. Insert tab - Quick Parts – Auto Text - Save Selection to Quick Parts Gallery 

5. Give your AutoText a name to be able to track it: Example: Registration 

6. Close without saving 

7. Open a new document, insert your page header from previous exercise, located in the 
Gallery (Header) 

8. Also insert this one (Registration). Insert tab - Quick Parts – Auto Text. 

REGISTRATION IN OFFICE AUTOMATION 

FIRST AND LAST NAME:  

TRAINING DATES:  

COURSE TITLE:  
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 ADD AN ITEM TO THE WATERMARK GALLERY

 Open a new document 

 To insert the "PROJECT" Watermark, click Design (Layout 

in previous versions) 

 Click Watermark in the Page Background group 

 Click Custom Watermark...  

 Click Text Watermark, type PROJECT  

Click OK 

   

 To keep PROJECT in the gallery, double-click in a page header 

 Click on the word PROJECT 

 From Watermark in Design, click Save Selection to Watermark Gallery... 

 Type PROJECT, make sure you are in the correct gallery, and click OK 

 

 Open an existing document and choose PROJECT from the list 

 This new watermark belongs in your gallery now.  

 DELETE A QUICK PARTS

 In Quick Parts, click “Building Block Organizer" 

 You can sort by “Name or Gallery or Category” and then 

"Delete" 

 To Edit an AutoText 

 Insert it, repeat the steps to save to the Gallery under the 

same name 
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 A message will ask you to Delete or Insert or  

Edit Properties…, click " YES" 

   

 

 

In the Forms documentation, we are going to experiment, Save 
to Custom Gallery.... Because we can also use Quick Parts in a 
form. 
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 Templates & Forms  

1. Enable the “Developer" tab in the ribbon  

 File, Options, Customize Ribbon, check Developer  

 USING A TEMPLATE

When creating a new document, Word is always based on a basic document called a "template". This 
can be either Normal.dotx or Normal.dotm. if it contains macros.  

A template is not a document like any other, it differs from a standard document by:   

 The extension of his name  

 The way it opens  

 The folder where it should be stored 

 The automatic insertions and building blocks specific to this model  

 Styles specially associated with this model  

 The macro commands included in this model  

The default document template in Word is called NORMAL.DOTX or .DOTM. The blank 
document that opens automatically when Word is launched is based on this template: 

 File, New, Click Template Name   

 Word gives you access to a copy of your template (e.g. Document1)  

 Enter data  

 Save and Word automatically prompts you for a new name for the file  

 CREATING A TEMPLATE:

1. Create the document that will serve as a template for other documents  

2. File, Save As, give the file a name   

3. In File Types, Click Template  

4. Word will automatically put the DOTX extension to your file (e.g. fax.dotx). If it must contain 

macros, use the DOTM extension  

 EDIT A TEMPLATE: 

1. Open Word, then open your template 

2. Click on the name of the template  

3. Make changes  

4. Save and give the same name. Word will ask you if you want to replace the existing file.  
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 DEVELOPMENT OF THE FORM 

First, establish the margins of the document, the sections if desired, the headers or footers of the entire 
document.  

Then create a table or set up the tabs so that the fields are arranged in the right places.  

 DIFFERENTIATING BETWEEN CONTENT CONTROLS AND LEGACY FIELDS 

Content controls to be used if all users have 2007 or newer. 

 BENEFITS: 

 More control types including rich text, images, and calendar for date selection  

 The document does not have to be protected, so advantage for accessibility, spelling, etc.  

 The entire document can be blocked by the "Group” button 

  

 It can be programmed so that it is destroyed or unlinked after it has been filled  

 Possible links to XML data source  

 DISADVANTAGES: 

 Inability to save only data in a Word document  

 You cannot easily link a macro to a control  

 You cannot give a format to a control ($)  

 You cannot do calculation  

 You cannot limit the length of an entry  

 It cannot be used in the 2003 version  

 Content controls and inherited fields can be combined  
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 Creating a form with new controls  

 Most beautiful (Blue-Grey)  

 Easy for users to use and understand  

 Styles can be applied to them  

 Their modification and deletion can be prevented  

 INSERTING A CONTENT CONTROL 

 Position the cursor where the control should be inserted  

 Make sure "Developer" mode is enabled  

 Select one of the control buttons to insert it into the form 

 

BUTTON DESCRIPTION 

 
Rich Text - Allows input of text that can be formatted (bold, italics, etc.) 

 
Inserts a Text field for data entry. Text input without formatting 

 

Combo: Inserts a drop-down list field, allowing you to choose from a list. 

Other values can be entered 

 

Inserts a drop-down list field, allowing you to choose from a list.  

No other values can be entered 

 

Where a user will be able to choose a "Quick Parts" from the specified 

gallery 

 
Inserts an Image control 

 
Allows you to insert a date selection control 

 

Checkbox - Displays an "on/off" switch New in 2010 

 
Repetitive Content Control  
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BUTTON DESCRIPTION 

 
A control is generic when inserted. The context must be given through the 
properties window 

 
We will utilise Design Mode to replace text inside the control 

 

Inserts another tool (version 2003) or Activex control 

 VALUES COMMON TO ALL CONTROLS 

 Title: The name given and displayed at the top of the control  

 Select the Do not delete content control check box, which allows the content of the control 

to be edited but prevents the actual control from being deleted from the template or from a 

document based on the template.  

    

 Select the Do Not Edit Content check box, which allows you to delete the control, but not to 

edit the content of that control. 

 STYLE OPTIONS 

 By default, the field takes the formats of the paragraph to which it belongs. However, it is 

possible to apply a particular style to the field. A style can be applied to plain text, rich text, 

and drop-down lists.  
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 MULTI-PARAGRAPH TEXT OPTIONS 

 For plain text only, the "Enter" key can be used to have multiple paragraphs. 

  

 OPTIONS TO REMOVE CONTENT CONTROL 

  For plain and rich text, it is allowed to delete the title and its tab when a field is populated. 

This causes the text to appear to have been entered off-screen.  

 LIST OPTIONS 

 You have the choice between an editable or non-editable drop-down list  

  

 DATE OPTIONS 

 Select the format in which the date is displayed according to the location.  
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 CHECKBOX OPTIONS  

It is possible to control the appearance of the checkbox whether it is checked or not. By default, a square 
is presented, but it is possible to modify this square with another symbol.  

 Change the color 

 Change the size 

  

 HOW TO CREATE AND INSERT A BUILDING BLOCK

All auto-inserts, building blocks, and equations are available when using this field. You can choose a 
category from a gallery.  

First, if your goal is to have a form filled out with a building block, you need to save your document as a 
TEMPLATE. 

1. Open the Building Block file 

2. Save as Template and keep the same name  

3. Select an image  

4. Click Insert, then Save Selection to Quick Parts 

Gallery...   

 

5. Give a new name if needed 

6. In Gallery, choose Custom 1  

   

7. In Category, create a new category called Picture 

8. Repeat the same process to save at least 3 or 4 images in the same category 
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9. To insert your building block where you want it, click the button in the Controls group. 

   

10. Click on Properties to choose your gallery and category and see the result. 

 LEGACY FORMS

 

BUTTON DESCRIPTION 

 
Inserts a text field 

 
Inserts a checkbox field. 

 
Drop-down list 

 
Inserts a frame. 

 
Displays field areas in gray (making them easier to spot). 

 
Resets the form.  

 ADD PROTECTION TO THE FORM. 

Once the inherited fields have been inserted into the form and the formatting and layout has been done, it 
must be locked to prevent some of the text from being erased and to make the fields operational. 

You can protect each content control in a template to prevent someone from deleting or modifying a 
particular content control or group of controls, or you can password-protect all content in the template.  
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 PROTECT ALL CONTENT ON A FORM 

 Open the form you want to protect.  

 On the Developer tab, in the Protect group, click Protect Document, and then click Restrict 

Editing.  

 In the Protect Document task pane, in Restrict Editing, select the Allow only 

this type of editing in the document check box.  

 From the list of Editing restrictions, select Filling in forms.  

 In Enable Protection, click Enable Protection.  

 To assign a password to the document so that only reviewers who know it 

can remove the protection, type a password in the Type a new password (optional) box, 

and then confirm it.  

 Important If you choose not to use a password, anyone can change your change 

restrictions.  

    

 LOCKING SECTIONS 

This type of lock makes it possible to make an area of the form accessible, previously formatted by a 
section. You can then unlock an entire section, for example to enter a large amount of text. It is preferable 
to choose a Continuous section break here if you want to get the data on the same page.  

 Make sure there are at least two sections in your form. Move the cursor to the section you 

want to unlock.  

 Click TOOLS – DOCUMENT PROTECTION.  

 Choose Form, then...  

 Specify the sections to be protected.  

Note 

 _________________________________________________________________________________  

 _________________________________________________________________________________  

 _________________________________________________________________________________  



 

Word Intermediate   Page | 35 

 Create or run a macro 

In Word, you can automate common tasks by creating and running macros. A macro is a series of 
commands and instructions that you group into a single command to automatically execute a task. 

To save time on tasks you do often, group the steps into a macro. First, you record the macro. You can 
then run the macro by clicking a button in the quick access toolbar, or by pressing a key combination. It 
all depends on how you set them up. 

 CREATE A MACRO

 Click View or Developer - Macros - Record Macro. 

   

 Type the name of the macro. 

 

 To be able to use this macro in all your new documents, make sure that the Store macro in 

box contains All Documents (normal.dotm). 

 Now it is time to record the steps. Click the controls or press the keys for each step of the 

task. Word records your clicks and keystrokes. 

EXAMPLE 

1. Orientation in the layout (Landscape) 

2. Margin: Top and bottom at 3cm, Left's 4cm and right at 2.5 cm 

3. Create a page header with a logo and your company name 

4. Create a footer 

5. Insert the watermark of your choice 

6. Create a page border, In this section, only the first page 



 

Page | 36  Word Intermediate  

 TO STOP RECORDING,

 Click View or Developer - Macros - Pause Recording. 

 

 TO RUN THE MACRO 

 Click the Macros Button – Show Macros 

   

 Select your macro, and then select Run 

 ADD THE MACRO TO YOUR QUICK ACCESS TOOLBAR

 Click Customize Quick Access Toolbar 

 Choose More Commands 

 Click Popular commands from: 

   

 Click Macros 

 Click Add 
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 Click Modify 

 

 

 

 Choose a button image, enter a name of your choice, and then click OK 

 Additional Exercises 

 EXERCISE 1 - TAB

 Open a new document 

 Apply the following stops from the Tab dialog box  

 Type 4.5 cm in the Position text box  

 Make sure that the Left option in the Alignment group 

and the None option in Leader 

 Click Set 

 Type 10 in the Position text box, this measure replaces 

the previous entry 

 Select the Center option in the Alignment group 

 Click Set 

 Type 14.5 in the Position text box  

 Select the Decimal option in the Alignment group 

 Click Set, then click OK  

 Observe the TABS on the ruler 
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Type the text below 
Product Product Code Quantity Price 

Cellular CE1343 40 215.00 

Radio RA3459 30 87.50 

CD player LL3987 25 136.75 

TV RL9543 9 4 345.00 

Modification to do: 
 TAB 14,5 Decimal to be replaced by Right Alignment  

 Move manually this TAB to the end of your paragraph 

 Save as:  "Tab" 

 EXERCISE 2 - TAB

Reproduce the text below: 

First name: ____________________________ Last name: __________________________________  

Address: ______________________________ City: _______________________________________  

Province: ______________________ P.O. Box: ____________ Date: __________________________  

 ----------------------------------------------------------------- --------------------------------------------------------------  

 EXERCISE 3 - TAB

 Open the "Resto Acropolis" file 

 Select the entire document (CTRL A) 

 Open Paragraph, Tab 

 Type 16.5 cm and select the Right option from the 

Alignment group 

 Select option No. 2 in Leader and set 

 Change Layout, Vertical Alignment:  

Take the time to see the difference between Justified 

and center 

  

Insert Symbol  (In Wingdings) 

Change the size and the color of your scissor 
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 EXERCISE - PROTECTION/COVER PAGE/SCREENSHOT

Objectif: Screenshot – Cover Page – Properties – Protection  
1. Open the Endangered Animals file and save it under the new name "Save the 

planet" 

2. Open your Internet browser and look for an image of a tiger. Go back to Word without 

closing the browser and place the cursor between 2 paragraphs (where you want your 

picture). 

3. From the Insert/Capture/Screen Clipping, the latest one with the camera. This will go 

back to your last display, which is the web page. 

 

4. Then with the mouse, frame only the part of the image you want to keep  

5. Repeat step 2-3-and 4 to get a picture of Great white shark 

6. Insert one of the cover pages containing an image and a short summary – 

Insert/Cover Pages. Edit the photo with a photo of your choice that is related to the 

theme of the document.  
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7. Click on the image – Click on the "Change Image" button from the Image Tools tab. 

 

8. Type Panda or Tiger or White Shark  

9. Insert the Image 

   

10. Give a name to your document (File – Info – Title) SAVE THE PLANET 

11. Select your first page and Save in your Galley Cover Page 

  

12. Open a new document and verify if your Cover page is available. 

13. Protect your file as read-only to prevent your document from being altered. 

File/Info/Protect Document/Choose Always Open Read-Only 

 EXERCISE – MAILINGS WITH LETTERS

1. Open: Diploma 

2.  Start Mailings 

3.  Use the Excel database: School result 

4.  Insert Fields: Name – note and average 

5.  Criteria: THE AVERAGE MUST BE 
GREATER THAN OR EQUAL TO 60 

6.  You want to see % at the end of each Field, 
choose Edit Field and add % after field 

7.  Merge to a new document and check the 
number of pages, your result should be 26 
pages to print.  



 

Word Intermediate   Page | 41 

 EXERCISE – FORM

From the "Video Sheet.dotx" template, create a form according to the 
following instructions: (Remember, you need to open the 
TEMPLATE with WORD (File – Open) 

1. Movie Title must contain a plain text field 

 Use a style to format content (Heading 1) 

 Check: Do not remove content control 

2. Release Date must contain a Calendar check 

 Select the format "d mmmm yyyy"  

3. Movie Description: Insert a Rich Text Control 

 Enable Delete Content When... 

4. In the cell to the left of the " With violence " row, insert a building block 

 Select blocks from the Custom 1 gallery and "Movie" category  

5. Under the Violent text, insert a "Checkbox" content control 

 Increase size to 16 points 

 Change the symbol to another of your choice. 

6. For "Duration" and "Featured" texts, insert "Plain Text" controls 

7. After the text Collation, insert a non-editable drop-down list control 

 Enter the following 4 choices: General, 13+, 16+, 18+ 

8. After the "Company" text, insert a Drop-down list (editable) control 

 Enter the following choices:  Astral, Universal Pictures, Walt Disney 

9. In the cell to the left of the "Movie Description" text, insert an image control 

10. Save your template and close it 

11.  Create a new document from your template and enter data for the last movie you saw. 


